Report Customization

This course covers the process for customizing reports using the SI 2015 Report Designer. Topics include a detailed overview of the designer, its tools and interface elements, adding fields to reports, inserting images, modifying header and footers in reports, creating and using sub-reports as well as creating a combined report.

Course Outline

Report Designer Tour

- New Report Wizard
- Report Structure Review
- Design interface Review

Report Modification

- Lab Exercise #1 – Modify the Cover Page
- Lab Exercise #2 – Create a Custom Contract
- Lab Exercise #3 – Using Sub-reports

Notes
New Report Wizard

This section explores the Report Designer Interface and the process to create a new custom report.

Creating a New Custom Report

1. From the Start Menu select Reports → Standard Report Designer.
   a. (Also available from the Manage Reports interface).
   b. The “Order Report Designer” provides the ability to customize task and service order reports.
   c. In order to use the Report Designer you must be granted the permission to customize reports from your D-Tools Administrator.

2. This opens the Report Designer interface. From here we can either create a new custom report or edit our existing custom reports. **Note:** Standard D-Tools reports cannot be modified (edited); we must create a copy of the standard report and modify it.

3. Now that the designer is open, create a new report by choosing File → New Report

4. You can also use the New report icon on the toolbar.

New Report Wizard – Step 1 - New or Based on Existing

1. Determine if the report will be created from the ground up or based on an existing report.
   a. Based on Existing – This allows you to create a copy of an existing report and modify it for your specific needs. This is the recommended method of customization
   b. New Report – this allows you to create a brand new report from scratch

2. For our training purposes in this course we are going to always create reports based on existing reports - **which is what we always recommend doing anyhow.**

3. Select New Report Based on Existing Report and Click Next

Notes

Since we have chosen to create a new report based on an existing report, this step is where we need to select which existing report to copy.

1. Select “Proposal w/ Graphics” from the Reports list
2. Click Next


1. Name the Report (Required)
   a. Tip: Name your custom reports consistently so they are easily found in the Reports list.
2. Name the report “Custom Proposal”
3. Set the Description (Optional)
4. Set the Category: Sets the report category where the report is grouped for selecting reports to run.
   This category can be modified later as well in Report Management.
5. Assign the Category as “Client Reports”
6. Select a Data Source: there is always only one choice so do not worry about this.
7. This is a Sub-report Checkbox: Do not check this off
   a. All reports can be a sub-report of another report.
   b. A sub-report is run along with a main report it is attached to.
   c. Marking a report as a sub-report makes it so it does not appear in the main reports list.
   d. Examples of sub-reports will be shown later in the course.
8. Change Order Checkbox: Do not check this off
   a. When this flag is checked, the report being created will only be visible in the Change Order list of reports located in the Project Compare Editor. It will not be used for regular reporting.
9. Include Options & Alternates: If this is checked, options and alternate items will be included in the report. If the report has the necessary script to identify them as options and alternates (such as with all of the latest stock D-Tools reports shipped with SI 2015) they will show up that way. Otherwise (such as with legacy reports), they will show up as regular items! On legacy reports you would want to leave this unchecked so those types of items are excluded.
10. Click Next

Notes

In this step we define page specific settings:

- Page Orientation (Portrait or Landscape)
- Paper Size (Leave as 8.5x11)
- Page Margins

**Note:** It is important to note that changing these settings DO NOT have a direct effect on the layout of the report in the designer. Changing the orientation or the margins will not automatically affect the “Width” of the report. By default, all standard reports (Letter paper size) that have the orientation set to “Portrait” have margins of 0.5 inches and a report canvas width of 7.5 inches. Changing the left and right margins will not automatically change the width of the report canvas. For example if you make the margins wider – this will require significant report design effort to move the various data fields to fit on a smaller page size.

New Report Wizard – Step 5 – Grouping/Sorting/Filtering

In this step we determine if a report should support Grouping, Sorting, or Filtering. These settings determine control how report definitions can be created.

1. **Support Sorting:** Determines whether the report sorting tab is available when creating report definitions in the Reporting Center.
   a. Sorting is not used in proposal reports. The order of items is determined by item level grouping later in the wizard.
2. **Support Dynamic Grouping:** Determines whether the report will use report definitions or not.
   a. When checked, report definitions will be available as will the use of dynamic grouping options for those definitions.
3. **Support Filtering:** Determines whether the user will be able to “Run Report With Filters”
4. **Assigned Properties:** These fields are available to be used for grouping, sorting or filtering.
5. **Available Properties:** These fields have not yet been assigned to the report to be used as a grouping, filtering or sorting field.

**Notes**
New Report Wizard – Step 6 – Required Groupings

In this step we determine if a report needs to have any Required Groupings. Some reports require that data be grouped in a specific manner in order to generate the desired results. Setting the required groupings accommodates this necessity.

Example: In the case of the Proposal Reports, regardless of how the items are dynamically grouped at run time (the Report Definition), in order for the report to aggregate properly, the items must be grouped (ascending sort) by Manufacturer, Model and ItemHash. Grouping by Manufacturer and Model gets the like items in order together; the ItemHash property differs on like items when the child items (items in a package or accessories of an equipment item) of the like items are different. Do not change these required groupings on the proposal reports – otherwise you will not be able to show the details of a package or the accessory details of a parent product.

New Report Wizard – Step 7 – Required Sorts

In this step we determine if a report needs to have any Required Sorts. If the items in a report must always be ordered in a specific way, the user can define a Required Sort. This works well for items that are not already using required groupings.

Note: Required Sorts do not work well on the proposal reports – they are best used on reports that are not grouping and aggregating the data as heavily as the proposal reports are. The items in a proposal are always sorted by Manufacturer, Model and ItemHash – this any sorting you do happens after these “required groupings” – and typically has little or no effect.

Details regarding this reasoning: Required Sorts can have minimal effects on the ordering of items depending on a number of things. For example, in a Proposal, the section that represents the details of proposal is actually a group header section that is tied to the ItemHash data field. This allows the report engine to aggregate items (sum the quantity of each item and create a single entry in the report). Since no actual detail records are being shown, a required Sort will have no effect on the presentation of the data.

Report Parameters allow for more complex control over the reports behavior. Many of the D-Tools proposal reports have parameters built in to them that we can use to pre-set our preferences for the report’s display options.

In this step we can predefine the parameters for the report template. While parameters are named and defined at this point, simply defining a parameter does not mean that it has any effect on the behavior of report. In order for these parameters to run, there needs to be entry made into the actual script (code) for the report. This is a very advanced feature set and will not be covered in this course.

**Parameters have the following parts:**

1. **Name** - a short string used as the key
2. **Description** – User prompt displayed in the Report Definition UI.
3. **DataType** – The value type of the parameter (String, Double, Integer, Boolean)
4. **Valid Values** – Values that the user can select from in the UI.
5. **Default Value** – The value selected by default in the UI if not previously set.

In order to create and use parameters you need to define the parameter here, and then reference the value of the parameter in the script, where you will write a script to tell the report what to do based on the value of the parameter.

**New Report Wizard – Step 9 – Review and Save**

1. Review the Report settings and Click “Finish”
2. This opens the report for editing in the Report Designer

**Notes**
Report Structure Review

Main Report

All components of a report are children of the main report. Beyond the child components (Sections, Fields, Sub-reports) and their specific properties, the report itself has a number of properties that may be set. By selecting the Report property in the Report Explorer you are presented with the Report’s properties in the Properties window.

Sections

The report is made up of various different types of sections that behave differently and allow the report to display the data in predictable ways. The order of the sections in the report affects the way the report’s data is grouped and displayed.

Notes
**Detail Section**

This is the only section that is required for a report (you can hide it but it cannot be deleted). As stated above, this section represents a single record in the reports data and will repeat for every instance of any record. (Quantities will not aggregate here). Every item in the report will get its own line in the report output. This is why the details section is not used in the proposal reports. Detail sections are used for reports such as a wire or equipment checklist where each item is displayed on its own line.

**Report Header and Footer**

The report header and footer sections will print once per report. The header will be the first section rendered for the report and the footer will be the last section. If you want something always at the very beginning (Cover Page) or at the very end, use a report header and footer.

**Page Header and Footer**

The page header and footer sections will print once per page. The page header will always be the very first section rendered to a page in the report and the page footer will be the very last section rendered at the bottom of the page in a report.

**Group Header and Footer**

The Group header and footer sections represent the most powerful sections in the report. Group sections allow users to aggregate data into subtotals, counts, etc. Every Group Header in a report has a property called a "DataField". This property is set to the field in the data set the report is iterating over. Every time the value changes in this field, a new instance of the report group is created.

Example: If the group is set to "Location", the data records are first sorted by location and then a new group entry is created each time the location changes. So when the report generates we will have our data records grouped together into Location specific groups.

**Notes**
Dynamic Group Header and Footer

The Dynamic Group header and footer sections are bound to the fields selected in the specific report definition. If Dynamic Grouping has been enabled, the report allows the user to create dynamic group settings in the report’s definition and control how the report data is grouped and displayed. This gives you the effect of a group header section described above, but the “DataField” property is dynamically set via the report’s definition.

Report Explorer

The Report Explorer gives us a road map for the report we are editing. It shows all of the various sections in the report as well as the various controls in each section. Selecting a control or section in the Report Explorer selects that control or section in the report designer and will also bring up the properties for that object in the Properties window.

Data Explorer

The Data Explorer gives us a road map for the data fields available to us from the D-Tools Project XML file. The data in the Data Explorer is grouped in sections as it is organized in the XML File. This is where we can find database fields for use in the report design.

- **dtr:DTtoolsReport** – this section holds all of the information available for the report. It has two sub elements:
  - **dtr:ReportCriteria** – this stores all of the data entered for the report in the report creation wizard that guides how it will be run. We do not use this information here.
  - **dtr:Project** – This stores all of the Project related data that we may want to use in customizing our report. This is used to find the specific data fields that can be used in the report design.

Notes
Design Interface Review

**File Menu**
- New
- Open
  - Open Existing Report (Already Published)
  - Open Unpublished Report (Not Published Yet)
- Edit D-Tools Report Information: Takes you back to the Report Wizard to make changes to the setup
- Edit Report Definitions: This allows you to create/ edit Report Definitions for the report
- Preview: Previews the report in the designer using a sample project pre-loaded into the designer. Previews use the “Default Definition” as its basis for generating the sample.
- Save For Later: Saves a draft (unpublished report)
- Publish Report: publishes the report to be used in reporting
- Publish and Export to the Server: This exports the report to the server for other users to import and also for the report to be backed up.
- Exit

**Edit Menu**
- Undo & Redo
- Cut, Copy, Paste & Delete
- Select All

**Toolbar**
- File Menu Options
- Edit menu Options
- Zoom In & Zoom Out
- Formatting Tools
  - Text Alignment Tools
  - Object Alignment Tools

**Notes**
Report Designer Toolbox

There are various types of controls that can be added to a report. Controls are the elements used in the report to display information, whether it is a picture, static text or a data field, they are all represented on the report using one of the Report Controls. In this course we highlight the main controls typically used in D-Tools reports.

- **Textbox** - The Textbox control is the primary control used to represent Project Data in a report.
- **Label** – This control is used to display fixed Text
- **Rich Text Box** – This control can be used to load text from a Rich Text File
- **Picture** – This control stores a picture loaded from a file
- **Line** – This allows you to draw a line
- **Page Break** – This allows you to insert and force a page break
- **Sub-report** - This allows you to bind any report marked as a “Sub-report” into the main report.
- **Cross Section line:** Allows for a line to be drawn that crosses through the various sections of the report, example: to have a line run down the side of every page regardless of which sections print on that page.
- **Cross Section box:** Allows for a box to be drawn that crosses through the various sections of the report, example: to have a box run down the side of every page regardless of which sections print on that page.

**Note:** Each of these tools will be demonstrated later in the course when we modify a report.

Design & Script Views

The Design Tab is the tab that displays the graphical report layout and editing screen. The script tab consists of the Visual Basic code that governs many of the internal functionalities of the reports and the report’s parameters. Many times, changes to the behavior of the report can only be made by modifying the script. This type of modification is not covered in this course.
Lab Exercise #1 – Modify the Cover Page

This lab focuses on modifying the cover page that is included with the Proposal report.

Modification #1 – Increase the Size of the Cover Page Canvas

1. Preview the report as it is right now
2. Notice that the Company Name & Address appear very high on the page.
   a. We are going to make them appear further down toward the bottom of the page.
3. In the Report Header1 Section of the report (this is the part storing the cover page elements) locate the Company Name and Address Fields at the bottom of the section.
4. At the bottom of the section you can see that the section is only 7.5 inches in height. We want to make it 8.5 inches high.
5. Hover the mouse over the section divider and move the section down until it is next to the 8.5 inch mark on the ruler.
   a. Note: If we go too far down the Report Header will span two pages (which we do not want). You have to take into account the page header and page footer as well as any fields that grow in size such as the addresses.
6. Exact section height modifications can be made using the properties window.
   a. Select the Report header frame at the top of the section (where it says “ReportHeader1”)
   b. Look at the properties box which now shows the section’s properties.
   c. Modify the height property = 8.5”
7. Select both the Company name and address fields and move them down the page.
8. Click Preview to show that the now appear further down on the Cover Page.
9. Preview the report to see how it looks
Modification #2 – Text and Field Modifications

1. Select the “Project Name” Field
2. On the Toolbar, change the Font size to be = 18
3. Using the Properties window, on the size property, make the height = 0.25
4. Select the “Project Company” Field – (This is the “Client Name” from the project)
5. On the Toolbar, change the Font size to be = 12
6. Using the Properties window, on the size property, make the height = 0.25
7. Select the “Project Address” Field
8. On the Toolbar, change the Font size to be = 12
9. Using the Properties window, on the size property, make the height = 0.25
10. Select the Company Name Field
11. On the Toolbar, change the Font size to be = 12
12. Using the Properties window, on the size property, make the height = 0.25
13. Preview the report to see how it looks

Note: To resize text boxes you can also manually resize them – I have found that using precise sizes via the properties is easiest to ensure consistency in your reports.

Modification #3 – Modify Existing Pictures

The logo on the Cover Page is pulling the logo uploaded to D-Tools during Setup. The large picture on the Cover Page is pulling form a picture you define in the report settings. Sometimes these pictures do not appear large enough or appear skewed due to aspect ratios, etc. So we want to be able to resize them appropriately.

1. Select the picture and resize it using your cursor.
2. OR – resize it using specific dimensions in the properties window.
3. Preview the report to see the result of your modification
4. Tweak as needed!

Notes
Modification #4 – Insert New Pictures

Sometimes you want to add additional logos on your cover page, perhaps a trade association logo, or other affiliations that distinguish you. We can insert new pictures into the reports pretty easily.

1. From the reports toolbox select a picture control and drag it out onto the page. Position it where you will want it to go (approximately).
2. In the Properties window find the Image Property
3. Select the Property and click on the little grey button to the right of it.
4. This opens a browse dialog box. Browse out and select your picture and click “Open” to insert the image into the report.
5. Resize the image to make it appear larger on the page.
6. There are a few properties for images you will want to know about in order to have your image appear correctly on screen.
7. With your picture control selected, look at the properties box:
   a. Picture Alignment: You can choose how you want your picture aligned in the box.
   b. Size Mode: There are three size modes you can choose from, the most common is ‘Zoom’ as it zooms out so the picture consumes the entire picture box.

Modification #5 – Insert a Data Field

This section demonstrates the process for inserting a text field into the report so that it will generate data from the D-Tools project. There are two main methods to add a data field to the report.

Method #1 – Drag and Drop

1. Navigate to the Data Explorer – this is where available data fields are located
2. Expand the tree and browse to the “dtr: Project ” list and expand it
3. Select the field: “dtr:ProjectNumber” and drag it on to the report
4. Once it is on the report you may want to edit the Text Property field so you know what data that box represents.
5. Select the text box, go to Properties and find the Text property. Type in “Project Number”
6. Now format the font size = 8 and move the shape into position on the Cover Page.

Notes
Method #2 – Data Field Insertion

1. Add a Textbox Control on to the report
2. Navigate to the Data Explorer
3. Expand the tree and browse to the "dtr: Project " list and expand it
4. Select the field: “dtr:ProjectNumber”
5. Right Click and select “Copy Data Field”
6. Now select your Textbox control on the report and navigate to its Properties window
7. Find the DataField Property box
8. Paste the copied Data Field form the Data Explorer into the Data Field property box
9. Now find the Text property box and name the box “Project Number”

Publish the Report

Publishing the report allows it to be run against a D-Tools project from the reporting interface. A report cannot be used for project reporting until it has been published. If you save and close the designer without publishing, your report will be listed under the “Unpublished Reports” list in the report designer.

1. Click on the Publish Icon or use File → Publish Report
2. When prompted to close the Designer and return to the Reporting Center, Select “Yes”

Publish the Report, Export to Server

This option publishes a copy of the report to the location you have defined in your report settings. This allows for other users to easily import the report to their local D-Tools installation and also includes the reports in the D-Tools backups.

Notes
Lab Exercise #2 – Create a Custom Contract

In this exercise we build a custom contract based on the existing D-Tools contract report.

Modification #1 – Create the New Contract Report

1. Click the New Report icon on the Report Designer Toolbar. This opens the New Report Wizard
2. Click to create a report based on an existing report.
3. Select “Contract” from the list and click Next
4. Name it “Training Contract”
5. Set Category = Client Reports and Click Next
6. We can just click through the remaining options in this wizard because we are not changing any of the settings – we are only going to change the content of the report to include our terms and conditions.
7. Finish the Wizard at the last step by clicking Finish
8. The report now opens for editing

Modification #2 – Insert New Report Text

For the new report's terms and conditions we are going to use a Rich Text box Control. This will allow us to insert the text directly from a Rich Text word document. The Contract is split up into two sections, one block of text shows up prior to the Payment details and the other block shows up after the payment details.

1. Select the first Rich Text box at the top of the Details Section
2. Right Click and select “Load File”
3. This brings up a file selection dialog box. Browse out and select the “Contract Section A.rtf” file that has been included with your training materials.
4. Click Open to import the text
5. Repeat this step for Section B using “Contract Section B.rtf” word file.
6. Preview the report to show that the new text has been imported into Sections A and B
7. Notice that the Payment schedule is broken in half and part of it appears at the bottom of page one

Notes
8. In order to keep this from happening we can use a Page Break control to force a page break prior to the payment schedule in the report.

9. From the Report Control toolbox, drag a page break control onto the report and place it in between the two sub reports.

10. Now preview the report and verify that the report breaks pages before the Payment schedule runs

11. On Page #3 at the bottom of the contract, notice that just a few lines of the report did not make it onto page #2.

12. Move the signature lines closer together in order to make the contract fit on two pages.

13. Publish the report

Lab Exercise #3 – Create a Combined Report

In this exercise we will build a combined report, adding the contract to the end of the Proposal.

Modification #1 – Create the Contract as a Sub-report

Adding the contract as a sub-report to the proposal is not as important as it used to be in prior version of D-Tools now that we can combine report groups into one pdf. I still think it is a valuable exercise as it teaches you the interaction between main report and sub-report in a straight forward manner.

1. Click the New Report icon on the Report Designer Toolbar to open the Report Creation Wizard
2. Click to create a report based on an existing report.
3. Select “Training Contract” from the list and click Next
4. Name it “Training Contract-Sub-report”
5. Check off the Box for “This is a Sub-report”
6. We can just click through the remaining options in this wizard because we are not changing any of the settings – our only objective for this step is to recreate the contract as a sub-report
7. Finish the Wizard at the last step by clicking Finish
8. The report now opens for editing

Notes
Modification #2 – Customize the Contract to be used as a Sub-report

Since the report is going to be used only as a Sub-report, there are changes we can make so that it will work properly when inserted into another report as a Sub-report. When using Sub-reports, the Page Header/Footer are ignored from the Sub-report and only the page header/footers from the main report are used. So in this case we can do one of two things with our Page Header Sections: We can make them invisible or we can delete them from the report. Making them invisible allows you to use them again in the future without recreating.

1. Select the Page Header section
2. In the Properties window, find the Visible property
3. Set Visible Property in the Properties window to “False”
4. Do the same for the Page Footer.
5. Now we need to modify the Group Header section. It currently has the company logo and all project information displaying. Since this information is already showing on the front page of the Proposal we can remove it from our Sub-report
6. We will go ahead and make this invisible as well. Set the visible property = false. You can collapse it so that we do not have to look at it while designing.
7. Now we want to insert a new group header to store some header text for the contract.
8. Right Click on The GroupHeader1 section and choose Insert → Group Header/ Footer.
9. In the new Group Header Section add a Label control
10. Select the Label and go to its Properties window
11. Set the Text Property to “Project Contract Terms” by typing it into the 'Text' Property
12. Format the Label field to be Size = 14 and Bold
13. Now we need to change its location and size as appropriate. Move it into a position you prefer.
14. We also inserted a Group Footer along with the header (they go hand in hand). Set its visible property = false.
15. Now the report is ready to be inserted as a Sub-report to the main report we created earlier
16. Publish the report

Notes
Modification #3 – Create the Combined Report

1. From the Toolbar in the Report Designer, click Open → Existing Report.
2. From the list, choose the Proposal from earlier and click OK.
3. Now that we have the report open for editing, we can make a few modifications to prepare for the Contract to be inserted.
4. In the "grpSummaryDetail" section at the bottom of the report we can delete the signature information (because this information is already included in our contract). Note: you could also make it invisible.
5. Select all of the signature information and delete them from the report.
6. Now we need to add a page break control on to the page after the Project Summary Sub-report - this will insert a new page before our contract is displayed so that it starts at the top of its own page after the project pricing summary.
7. Drag a Page Break out on the page and place it beneath the Project Summary Sub-report.
8. Drag a Sub-report control onto the report. It appears large by default – we will resize.
9. Select the Sub-report control.
10. In the Properties window find the Size Field -- Set the Size to 7.5, 0.25 in (7.5" width, 0.25" height).
11. Move the new subreport so that it is underneath the page break control we inserted earlier.
12. Reduce the height of the "grpSummaryDetail" section by dragging from the bottom of the section.
13. Select and Right Click on the Sub-report.
14. Select the option – "Bind to D-Tools Report".
15. Select the "Training Contract – Sub-report" and Click OK.
16. Now preview the report.

Note: It may take some fine tuning to get your Sub-report created in just the right way so that the page breaks work properly when it is inserted to the main report. In order to do this you will need to edit the Sub-report and publish it, its reference to the main report will persist, and you do not need to keep binding the report each time.

Notes